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1. Introduction
1 Introduction

1.1 Target group

This documentation is aimed at users with the following knowledge and skills:

Advanced KRL programming skills
Advanced knowledge of the robot controller system
Advanced knowledge of measuring technology
Advanced knowledge of sensor systems
Advanced knowledge of image processing

1.2 Robot system documentation

The robot system documentation consists of the following parts:

Operating instructions for the robot
Operating instructions for the robot controller
Operating and programming instructions for the KUKA System Software
Documentation relating to options and accessories

Each of these sets of instructions is a separate document.

1.3 Representation of warnings and notes

Safety Warnings marked with this pictogram are relevant to safety and must be ob-
served.

Notes Notes marked with this pictogram contain tips to make your work easier or ref-
erences to further information.

For optimal use of our products, we recommend that our customers take part 
in a course of training at KUKA College. Information about the training pro-
gram can be found at www.kuka.com or can be obtained directly from our 
subsidiaries.

Danger!
This warning means that death, severe physical injury or substantial material 
damage will occur, if no precautions are taken.

Warning!
This warning means that death, severe physical injury or substantial material 
damage may occur, if no precautions are taken.

Caution!
This warning means that minor physical injuries or minor material damage 
may occur, if no precautions are taken.

Tips to make your work easier or references to further information.
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1.4 Terms used

1.5 Trademarks

Microsoft is a trademark of Microsoft Corporation.

Windows is a trademark of Microsoft Corporation.

Term Description
Hole pattern Position of the drilled holes
DB Database
HD = hard disk Hard drive
Camera frame A result file when calibrating with 

the Krypton system
Krypton computer PC with Krypton software installed
Krypton strober Distributor for connecting multiple 

LEDs to a single output
PID data Parameter identification file of the 

robot
RDC Resolver Digital Converter
RCS Robot calibration system
Tool LEDs LEDs that are calibrated by the 

Krypton camera during every cali-
bration operation.

Tool locating holes Tool locating holes are required for 
measuring the tool with the Krypton 
camera.

X-Rob XRob stands for a product family.
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2. Product description
2 Product description

2.1 Overview KUKA.XRob RCS

KUKA.XRob RCS is an add-on technology package with the following func-
tions:

Functions XRob RCS configuration database for configuration of robot types.
XRob RCS Wizard for execution of zero mastering and absolute calibra-
tion.

2.2 Functional principle

Description The high-accuracy robot positions the programmed TCP anywhere in the Car-
tesian workspace with a predefined tolerance. The model parameters of the 
high-accuracy robot are determined at a calibration station (RCS). They are 
permanently saved on the robot (RDC). 

Robot calibration 
(calibration process)

Zero mastering During zero mastering, the robot is moved to different poses with a calibration 
panel mounted. The Krypton camera measures the positions in space of the 
LEDs on the calibration panel. The axis offsets that are saved on the RDC 
when the new zero mastering is carried out are optimized.

Absolute calibration For absolute calibration, the maximum payload is mounted on the robot. Up to 
100 axis-specific poses, distributed throughout the workspace of the robot, are 
measured. These 6D measurements are used to calculate the optimizable pa-
rameters of the robot model which are written to the RDC. The quality is 

Fig. 2-1: Positional accuracy

1 Setpoint position 
2 Repeatability 
3 Positioning of the absolutely accurate robot 
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checked in suitable Cartesian poses by means of a verification measurement 
with the Krypton camera.

1 Krypton camera
2 Calibration panel 
3 Robot

1 Calibration panel
2 Krypton camera
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3. Safety
3 Safety

All persons working with the robot system must have read and understood 
the robot system documentation, including the safety chapter.
The positionally accurate robot model is only valid for the robot as deliv-
ered.
Following conversion or retrofitting of the robot, e.g. with an arm extension 
or a new wrist, the robot must be recalibrated.
The robot system with KUKA.XRob RCS must be operated in accordance 
with the applicable national laws, regulations and standards.
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4. Installation
4 Installation 

4.1 Installation overview

4.2 System requirements

Hardware KR C2ed05
At least 512 MB RAM

Software Windows XP operating system
KUKA System Software (KSS) 5.5
KUKA.UserTech 2.2
Microsoft .NET Framework 2.0

4.3 Installing Microsoft SQL Server Desktop Engine

Precondition Windows interface
Local administrator rights
All Windows applications are closed

Procedure 1. Start the program Setup.exe from the CD-ROM.
2. Reboot the computer. The installation is resumed and completed.

LOG file LOG files are created in the directory C:\PROGRAM FILES\MICROSOFT 
SQL SERVER\MSSQL\LOG.

Step Description
1 Check system requirements of the 

robot controller.

 (>>> 4.2 "System requirements" 
page 11)

2 Install Microsoft SQL Server Desk-
top Engine MSDE.

 (>>> 4.3 "Installing Microsoft SQL 
Server Desktop Engine" page 11)

3 Install XRob database.

 (>>> 4.5 "Installing XRob.RCS 
database" page 12)

4 Install KUKA.XRob RCS database 
configurator.

 (>>> 4.6 "Installing XRob.RCS 
database configurator" page 12)

5 Install KUKA.XRob RCS Wizard.

 (>>> 4.8 "Installing XRob.RCS 
Wizard" page 13)
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4.4 Uninstalling XRob database

Precondition Microsoft SQL Server Desktop Engine is installed.

Procedure 1. In the Windows Start menu, select Settings > Control Panel > Software 
and uninstall the Microsoft SQL Server Desktop Engine.

2. Delete the folder MICROSOFT SQL SERVER in the directory C:\PRO-
GRAM FILES.

4.5 Installing XRob.RCS database

Precondition Windows interface
Local administrator rights
All Windows applications are closed
Microsoft SQL Server Desktop Engine is installed.

Procedure 1. Start the program Setup.exe from the CD-ROM.
The Select Option window is opened.

2. Select Configuration database (Config DB).
3. Confirm with Next.

4.6 Installing XRob.RCS database configurator

Precondition Windows XP operating system
Microsoft .NET Framework 2.0 is installed.
Windows interface
Local administrator rights
All Windows applications are closed

Procedure 1. Start the program Setup.exe from the CD-ROM.
The Select Option window is opened.

2. Select Database configurator.
3. Confirm with Next.

The program is installed under C:\KUKA\XROB_RCS\CONFIGGUI.

4.7 Uninstalling XRob.RCS database configurator

Precondition Windows interface
KUKA.HMI is switched off.
KUKA.XRob RCS database configurator is installed.

Procedure 1. Select the folder Database configurator in the directory C:\KU-
KA\XROB_RCS.

It is advisable to archive all relevant data before updating or uninstalling a 
software package.

It is advisable to archive all relevant data before updating or uninstalling a 
software package.
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4. Installation
2. Delete the folder.

4.8 Installing XRob.RCS Wizard

Precondition Windows interface
KSS 5.5
KUKA UserTech 2.3 is installed
Local administrator rights
All Windows applications are closed.
The network connection is established

Procedure 1. Start the program Setup.exe from the CD-ROM.
The Select Option window is opened.

2. Select Install XRob RcsWizard.
3. Confirm with Next.

The program is installed under C:\KUKA\KRC\TP\XROB_RCS.

4.9 Uninstalling XRob.RCS Wizard

Precondition Windows interface
KUKA.HMI is switched off.
KUKA.XRob RCS is installed.

Procedure 1. Start the UnInstall.exe program in the directory C:\KRC_OPTION\XRO-
BRCS\UNINST.

2. Reboot the robot controller. Uninstallation is resumed and completed.

4.10 Re-installing XRob.RCS Wizard

Precondition Windows interface
Local administrator rights
All Windows applications are closed
KUKA.HMI is switched off
KUKA.XRob RCS is uninstalled.

Procedure 1. Start the ReInstall.exe program in the directory C:\KRC_OPTION\XRO-
BRCS\REINST.

2. Reboot the robot controller. Reinstallation is resumed and completed.

LOG file A LOG file is created under C:\KRC\ROBOTER\LOG.

It is advisable to archive all relevant data before updating or uninstalling a 
software package.
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5. Configuration
5 Configuration

5.1 Configuration overview

5.2 Opening the database configurator

Procedure 1. Start DB Configurator.exe.
2. The XRob RCS database configurator opens.

Step Configuration steps
1 Open database configurator

 (>>> 5.2 "Opening the database configurator" 
page 15)

2 Enter tool data

 (>>> 5.3.1 "Entering tool data" page 16)
3 Enter load data

 (>>> 5.3.2 "Entering load data" page 17)
4 Enter base data

 (>>> 5.3.3 "Entering base data" page 19)
5 Enter robot type data

 (>>> 5.3.4 "Entering robot type data" page 20)
6 Enter robot data

 (>>> 5.3.5 "Entering robot data" page 21)
7 Enter pose data

 (>>> 5.3.6 "Entering pose data" page 22)
8 Edit tool data

 (>>> 5.4.1 "Editing tool data" page 23)
9 Edit load data

 (>>> 5.4.2 "Editing load data" page 23)
10 Edit base data

 (>>> 5.4.3 "Editing base data" page 24)
11 Edit robot type data

 (>>> 5.4.4 "Editing robot type data" page 24)
12 Edit robot data

 (>>> 5.4.5 "Editing robot data" page 24)
13 Edit pose data

 (>>> 5.4.6 "Editing pose data" page 24)
14 Create new configuration

 (>>> 5.5.1 "Creating a new configuration" page 25)
15 Edit configuration

 (>>> 5.5.2.1 "Selecting a configuration" page 26)

 (>>> 5.5.2.2 "Modifying a configuration" page 27)
16 Configure RCS Wizard

 (>>> 5.6 "Configuration file XROBCONFIG.XML" 
page 27)
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3. Select the menu sequence Database > Open.
The data linking properties window is opened.

4. Enter server name, user name and password.
5. Select database on the server. Confirm with OK.

5.2.1 Saving settings

Description  Saving settings of the data linking properties window.

Procedure 1. Open the file DBKonfigurator.config in the directory C:\KU-
KA\XRob_Rcs\ConfigGUI.

2. In this file, carry out the settings for the server, user, password and data-
base.

3. Select the menu sequence File > Save and close the file.

5.3  Entering data in the database configurator

5.3.1 Entering tool data

Description The tool data contain the following information:

The measurement results of the mechanical calibration of the tool holes.
The measurement results of the optical calibration of the LEDs with the 
Krypton system.
The specification of the mass of the tool, flange adapter and panel, without 
a supplementary load, relative to the flange.
The specification of the center of mass of the tool, flange adapter and pan-
el, without a supplementary load, relative to the flange.

Precondition The coordinates of the tool LEDs are known and are stored in a file with 
the extension .tl.
The coordinates of the tool locating holes are known.
The mass and center of mass of the tool are known. 

Procedure 1. Select the menu sequence Data > New > Tool.
The input window is opened.

2. Enter an unambiguous designation for the tool in the Designation box.
3. Enter a comment in the Comment box (optional).
4. Load the coordinates of the tool LEDs by means of the File button. 
5. Enter the coordinates of the tool locating holes manually. Click into the box 

under X, Y, Z. <edit> appears. Enter the values for X, Y, Z from the cali-
bration log of the coordinate measuring machine.

6. Enter the mass of the tool in kg in the Mass box.
7. Enter the coordinates for X, Y, Z in mm in the boxes for the center of mass.
8. Confirm with OK.

A message window is opened.
9. Confirm the message with Yes.

<!-- SQL Server or MSDE configuration -->
<add key="DBHost" value="PCRC..."  />
<add key="DBUser" value="xrob..."  />
<add key="DBPasswd" value="xrob..."  />
<add key="DBName" value="Messplatz..."  /> 
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5. Configuration
The data are updated in the database.

5.3.2 Entering load data

Description The load data are factored into the calculation of the paths and accelerations 
and help to optimize the cycle times. 

Various loads can be mounted on the robot:

Payload on the flange
Supplementary load on axis 3
Supplementary load on axis 2
Supplementary load on axis 1

All loads added together give the overall load.

Fig. 5-1: Entering the tool data

There is a payload diagram for every robot. It can be used to check quickly 
whether the payload could be suitable for the robot. The diagram is not, how-
ever, a substitute for checking the payload with KUKA.Load.
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Parameters The load data are defined using the following parameters:

Reference systems of the X, Y and Z values for each load:

Precondition The mass and center of mass of the tool are known from the supplemen-
tary load data.

Procedure 1. Select the menu sequence Data > New > Load.
The input window is opened.

Fig. 5-2: Loads on the robot

1 Payload 3 Supplementary load on axis 2
2 Supplementary load on axis 3 4 Supplementary load on axis 1

Parameter Unit
Mass m kg
Distance to the center 
of gravity

Lx, Ly, Lz mm

Mass moments of iner-
tia at the center of 
gravity

Ixx, Iyy, Izz kg m2

Load Reference system
Supplementary load 
A1

ROBROOT coordinate system

A1 = 0°
Supplementary load 
A2

 ROBROOT coordinate system

 A2 = -90°
Supplementary load 
A3

FLANGE coordinate system

A4 = 0°, A5 = 0°, A6 = 0°
Payload FLANGE coordinate system
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5. Configuration
2. Enter an unambiguous designation for the load in the Designation box.
3. Enter the total mass in kg in the Mass box.
4. Enter the coordinates in mm in the boxes for the center of mass.
5. Confirm with OK.

A message window is opened.
6. Confirm the message with Yes.

The data are updated in the database.

5.3.3 Entering base data

Description The base data contain the following:

The coordinates for the reference LEDs on the baseplate of the calibration 
station.
The coordinate transformation between the Krypton camera and the robot 
base.

Precondition The coordinates of the reference LEDs of the baseplate are known and are 
stored in a file with the extension .prb.
The camera frame is known and is stored in a file with the extension .txt.

Procedure 1. Select the menu sequence Data > New > Base.
The input window is opened.

2. Select the suitable hole pattern for the robot.
3. Select the relevant mounting plate in the Mounting plate box. If there is 

no suitable mounting plate, create a new mounting plate. Press the New 
button. Specify a location for the mounting plate. Confirm with OK.

4. Select a calibration station in the Calibration station box. If there is no 
suitable calibration station, create a new calibration station. Press the New 
button. Specify a calibration station name. Confirm with OK.

5. Load the coordinates of the LEDs, e.g. LEDs.prb, by means of the File but-
ton. 

Fig. 5-3: Entering the load data
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Load the camera frame, e.g. Camera.txt, by means of the File button.
6. Confirm with OK.

A message window is opened.
7. Confirm the message with Yes.

The data are updated in the database.

5.3.4 Entering robot type data

Description The robot type data consist of the following data sets:

Robot type
Payload group
Hole pattern name

Precondition The payload group and the hole pattern name are known.
The hole pattern is available.

Procedure 1. Select the menu sequence Data > New > Robot type.
2. Enter an unambiguous name in the Robot type box.
3. Select the relevant payload group in the Payload group box. If there is no 

suitable payload group, create a new payload group. Press the New but-
ton. Enter the new payload group name. Confirm with OK.

4. Select the relevant hole pattern. The corresponding hole pattern name is 
displayed in the Hole pattern name box.

5. Confirm with OK.
A message window is opened.

6. Confirm the message with Yes.
The data are updated in the database.

Fig. 5-4: Entering the base data
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5. Configuration
5.3.4.1 Creating a new hole pattern

Description If there is no suitable hole pattern available, a new one must be created.

Procedure 1. Create the hole pattern in a graphics program and save it as a bitmap 
(bmp) with a resolution of 96 dpi and a size of 70x70 pixels.

2. Open the folder Picture in the directory C:\KUKA\XROB_RCS\CONFIG-
GUI.

3. Copy the hole pattern to the folder.
4. Close the folder.

5.3.5 Entering robot data

Description The robot data consist of the following data sets:

Payload group
Robot type
The robot type designates the basic machine type and payload, without 
taking an arm extension into consideration.
Arm extension
Installation type
Machine data directory 
Transformation name

Precondition The machine data are stored on the computer or network.

Procedure 1. Select the menu sequence Data > New > Robot data.
2. Select the relevant payload group in the Payload group box. 
3. Select the created robot type in the Robot type box.

Fig. 5-5: Entering robot type data
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4. Select the arm extension in the Arm extension box. If there is no suitable 
arm extension, create a new arm extension. Press the New button. Spec-
ify a name for the arm extension. Confirm with OK.

5. Select the relevant installation type in the Installation type box. If there is 
no suitable installation type, create a new installation type. Press the New 
button. Confirm with OK.

6. Load the corresponding robcor.dat in the Directory path: robcor.dat box. 
Press the File button. Select the corresponding robcor.dat in the machine 
data and confirm with Open.
The transformation name is displayed.

7. Confirm with OK.
A message window is opened.

8. Confirm the message with Yes.
The data are updated in the database.

5.3.6 Entering pose data

Description A pose set defines all the poses that are used for a calibration type for one ro-
bot type.

Precondition The system test poses, calibration poses and test poses are known and 
stored in a KRL.DAT file. 
The poses have been tested for collisions and visibility.

Procedure 1. Select the menu sequence Data > New > Poses.
2. Enter a name in the Pose set name box.
3. Load the system test poses, e.g. SPoses.dat, by means of the File button. 
4. Load the calibration poses by means of the File button. 
5. Load the test poses by means of the File button. 
6. Set the measurement tolerance. Select one of the system test poses. Set 

the value in the Tolerance sphere radius box. Press the Apply button.

Fig. 5-6: Entering robot data
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5. Configuration
7. Repeat step 6 for the calibration poses and test poses.
8. Confirm with OK.

A message window is opened.
9. Confirm the message with Yes.

The data are updated in the database.

5.4 Editing data

5.4.1 Editing tool data

Precondition The tool data have been entered and updated in the database.

Procedure 1. Select the menu sequence Data > Open > Tool.
The input window is opened.

2. Select the tool to be modified in the Serial number box.
3. Modify the desired tool data.
4. Confirm with OK.

A message window is opened.
5. Confirm the message with Yes.

The data are updated in the database.

5.4.2 Editing load data

Precondition The load data have been entered and updated in the database.

Procedure 1. Select the menu sequence Data > Open > Load.
The input window is opened.

2. Select the load to be modified in the Designation box.
3. Modify the desired load data.

Fig. 5-7: Entering poses
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4. Confirm with OK.
A message window is opened.

5. Confirm the message with Yes.
The data are updated in the database.

5.4.3 Editing base data

Precondition The base data have been entered and updated in the database.

Procedure 1. Select the menu sequence Data > Open > Base.
The input window is opened.

2. Modify the desired base data.
3. Confirm with OK.

A message window is opened.
4. Confirm the message with Yes.

The data are updated in the database.

5.4.4 Editing robot type data

Precondition The robot type data have been entered and updated in the database.

Procedure 1. Select the menu sequence Data > Open > Robot type.
The input window is opened.

2. Select the robot type to be modified in the Robot type box.
3. Modify the desired robot type data.
4. Confirm with OK.

A message window is opened.
5. Confirm the message with Yes.

The data are updated in the database.

5.4.5 Editing robot data

Precondition The robot data have been entered and updated in the database.

Procedure 1. Select the menu sequence Data > Open > Robot data.
The input window is opened.

2. Modify the desired robot data.
3. Confirm with OK.

A message window is opened.
4. Confirm the message with Yes.

The data are updated in the database.

5.4.6 Editing pose data

Precondition The pose data have been entered and updated in the database. 

Procedure 1. Select the menu sequence Data > Open > Poses.
The input window is opened.

2. Select the pose set to be modified in the Pose set name box.
3. Modify the desired pose data.
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5. Configuration
4. Confirm with OK.
A message window is opened.

5. Confirm the message with Yes.
The data are updated in the database.

5.5 Configuring robot types

5.5.1 Creating a new configuration

Precondition All data have been entered and updated in the database.

Procedure 1. Select the menu sequence Configuration > New.
The “Robot type and calibration station” tab is opened.

2. Enter an unambiguous name in the Designation box.
3. Enter a comment in the Comment box (optional).
4. Select the calibration type in the Calibration type box.
5. Activate Configuration active.

Active configurations are now available for selection in the RCS Wizard.
6. Select the desired payload group in the Payload group box.
7. Select the corresponding robot in the Robot type box.
8. Select the desired arm extension in the Arm extension box.
9. Select the relevant installation type in the Installation type box.

The corresponding directory path and transformation name are displayed.
10. Select the desired calibration station in the Calibration station box.
11. Select the corresponding mounting plate in the Base tab. 

The hole pattern name, hole pattern, coordinates of the LEDs and the 
camera frame are displayed.

12. Select the corresponding load in the Designation box on the Load tab.
13. Select the corresponding pose in the Pose set name box on the Poses 

tab.
14. Select the corresponding tool in the Serial number box on the Tool tab.
15. Select the relevant model in the Configuration name box on the Model 

tab.
16. Confirm with OK.

A message window is opened.
17. Confirm the message with Yes.

The data are updated in the database.
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5.5.2 Editing a configuration

5.5.2.1 Selecting a configuration

Procedure 1. Select the menu sequence Configuration > Open.
2. Only active configuration activated. Only active configurations can be 

selected.
Only active configuration not activated. All configurations can be select-
ed.

3. Select the desired calibration station in the Calibration station box.
4. Select the desired calibration type in the Calibration type box. 
5. Select the desired robot type in the Robot type box.
6. Select the configuration to be modified in the Configuration box.
7. Confirm with Apply.

The “Robot type and calibration station” tab is opened.

Fig. 5-8: Creating a new configuration
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5.5.2.2 Modifying a configuration

Precondition New data have been entered.
A configuration for a robot type and calibration station has been selected.

Procedure 1. Modify the load in the Designation box on the Load tab.
2. Modify the mounting plate in the Mounting plate box on the Base tab.
3. Modify the poses in the Pose set name box on the Poses tab.
4. Modify the tool in the Serial number box on the Tool tab.
5. Modify the model in the Configuration name box on the Model tab.
6. Confirm with OK.

A message window is opened.
7. Confirm the message with Yes.

The data are updated in the database.

5.6 Configuration file XROBCONFIG.XML

Description In order to be able to exchange data between the computers, links must be en-
tered in the XRobConfig file.

The configuration file XROBCONFIG.XML is situated, after installation of KU-
KA.XRob RCS, in the directory ...\KRC\TP\XROB_RCS\UTIL.

To edit XROBCONFIG.XML, the file must be opened in edit mode.

Precondition RCS Wizard is installed.
Windows interface

Procedure 1. Open the file XRobConfig in the directory C:\KRC\TP\XROB_RCS\UTIL 
using the editor.

2. Modify the following entries in the file:
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<General>
 <StationId>Messplatz 8</StationId>
</General>
...
<RcsAssistent>
 <!-- location of main MADA directory -->
 <MaDaRootDir>\\pcrc40382_3\RCS\MachineData</MaDaRootDir>
 <!-- location of used KRL programs-->
 <KRLProgramDir>KRC:\R1\Program</KRLProgramDir>
 <!-- location for XPId file output -->
 <XPIdOutputDir>C:\KRC\Roboter\IR_Spec</XPIdOutputDir>
</RcsAssistent>
...
<LanguageDatabaseLocation>C:\krc\tp\XRob_Rcs\Data\XRobLang.mdb</Lan-
guageDatabaseLocation>
 <!-- current set language for xrob -->
 <CurrentLanguage>de-DE</CurrentLanguage>
...
<ConfigDB>
 <!--network name or ip adress where database server is hosted, "lo-
calhost" 
 is for local system -->
 <DbHost>pc40367</DbHost> 
 <!-- name of the database --> 
 <DbName>MessplatzDB</DbName>
 <!-- default user name for database acces -->
 <User>xrob_user</User>
 <!-- default password for default database user -->
 <Password>xrob_user</Password>
...
<ResultDB>
 <!-- network name or ip adress where database server is hosted, "lo-
calhost" is for local system-->
 <DbHost>pc40367</DbHost>
 <!-- name of the database -->
 <DbName>resultdb</DbName>
 <!-- default user name for database acces -->
 <User>Name</User>
 <!-- default password for default database user -->
 <Password>testpas</Password>
</ResultDB>
...
<KryptonWorkingDir>\\pc40367\Austausch\rocal\bin</KryptonWorkingDir>
...
<KryptonRemoteHost>pc40367</KryptonRemoteHost>
...
<ShellLocation>C:\Windows\system32\cdm.exe</ShellLocation>
...
<IstFileName>C:\KRC\ROBOTER\IR_SPEC\Messdaten.ist</IstFileName>

Entry Description
<StationId>...</StationId> Calibration station created in the 

base data.
 <MaDaRootDir>...</MaDaRoot-
Dir>

Machine data path.

 <XPIdOutputDir>...</XPIdOut-
putDir>

Path of the file ErgebnisXRob.pid. 
The evaluation results are saved 
here.

<LanguageDatabaseLoca-
tion>...</LanguageDatabaseLo-
cation>

Path for the language database. 
This modification is optional.

<CurrentLanguage>...</Current-
Language>

Language setting in the language 
database. This modification is 
optional.

<DbHost>...</DbHost> Server name.
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 <DbName>...</DbName> Database name
<User>...</User> Predefined user name. This modi-

fication is optional.
<Password>...</Password> Predefined password. This modi-

fication is optional.
<KryptonWorkingDir>...</Kryp-
tonWorkingDir>

Path specification for the working 
directory of the Krypton software.

<KryptonRemoteHost>...</Kryp-
tonRemoteHost>

Name of the Krypton computer.

<ShellLocation>...</ShellLoca-
tion>

Path specification of CMD.exe on 
the Krypton computer. This modi-
fication is optional.

<IstFileName>...</IstFileName> Path for the results database

Entry Description
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6 Operation

6.1 Zero mastering with the RCS Wizard

Precondition Krypton RemoteControl.exe is started on the Krypton computer.
The data have been entered and updated in the database.
A configuration has been created and updated in the database.
The network connection is established.
Operating mode T1 or T2.

Procedure 1. Start the KUKA System Software (KSS) 5.5.
2. Select the menu sequence Monitor > XRob RCS > Show.
3. Press the Next softkey.

A prompt window is displayed.
4. Select the calibration type. Press the Zero mastering softkey.

The configuration window is displayed.
5. Select the data from the created configuration in the boxes Payload 

group, Robot type, Arm extension, Installation type and Mounting 
platform.

6. Press the Next softkey.
7. Enter the robot serial number in the prompt window.
8. Press the Next softkey.

The configuration name, the comment and the robot serial number are dis-
played.

9. Press the Next softkey.
A message window is displayed.

10. Press the Next softkey to confirm the message.
The “Tool mounting” prompt window is displayed.

11. Follow the prompt.
12. Press the Next softkey.

Fig. 6-1: Selecting a configuration
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The “Unmaster robot” prompt window is displayed.
13. Unmaster the axes.

14. Press the Next softkey.
The “Master robot in home position” prompt window is displayed.

15. Master the robot.

16. Press the Next softkey.
The “Test measurement for robot type check” prompt window is displayed.

17. Press the Next softkey.
The program for checking the robot type is displayed.

18. Set mode selector switch to Automatic mode. Start the program. Once pro-
gram execution has been completed, the result is displayed.

19. Press the Next softkey.
The “Carry out mastering” prompt window is displayed.

20. Start the program. Once program execution has been completed, the re-
sults are displayed.

21. Press the Next softkey.
A prompt window is displayed.

22. Follow the prompt. Press the Next softkey.
The “Carry out control measurement” prompt window is displayed.

Further information is contained in the operating and programming instruc-
tions for the KUKA System Software (KSS).

Further information is contained in the operating and programming instruc-
tions for the KUKA System Software (KSS).

On completion of the control measurement, a message window is displayed. 
System ready for measurement must be highlighted in green. If this is not 
the case, an error has occurred.  (>>> 8.1 "Causes of errors during the test 
measurement" page 43)

Fig. 6-2: Mastering results
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23. Press the Next softkey to confirm the prompt.
The program for the control measurement is displayed.

24. Start the program. Once program execution has been completed, the re-
sults are displayed.

25. Press the Next softkey.
A prompt window is displayed.

26. Follow the prompt.
27. Press the Next softkey.

A prompt window is displayed. Answer the prompt with the Yes or No 
softkey.

6.2 Zero mastering for KR spot and KR 5 with the RCS Wizard

Precondition Krypton RemoteControl.exe is started on the Krypton computer.
The data have been entered and updated in the database.
A configuration has been created and updated in the database.
The network connection is established.
Operating mode T1 or T2.

Procedure 1. Start the KUKA System Software (KSS) 5.5.
2. Select the menu sequence Monitor > XRob RCS > Show.
3. Press the Next softkey.

A prompt window is displayed.
4. Select the calibration type. Press the Zero mastering softkey.

The configuration window is displayed.

Fig. 6-3: Control measurement result

If the prompt is answered with Yes, the absolute calibration is started. If the 
prompt is answered with No, the Wizard can be closed. Press the Close 
softkey.
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5. Select the data from the created configuration in the boxes Payload 
group, Robot type, Arm extension, Installation type and Mounting 
platform.

6. Press the Next softkey.
7. Enter the robot serial number in the prompt window.
8. Press the Next softkey.

The configuration name, the comment and the robot serial number are dis-
played.

9. Press the Next softkey.
A message window is displayed.

10. Press the Next softkey to confirm the message.
A prompt window is displayed.

11. Follow the prompt.
12. Press the Next softkey.

The “Unmaster robot” prompt window is displayed.
13. Unmaster the axes.

14. Press the Next softkey.
The “Master robot in home position” prompt window is displayed.

15. Master the robot.

16. Press the Next softkey.
The “Test measurement for robot type check” prompt window is displayed.

17. Press the Next softkey.
The program for checking the robot type is displayed.

18. Set mode selector switch to Automatic mode. Start the program. Once pro-
gram execution has been completed, the result is displayed.

19. Press the Next softkey.
The “Carry out mastering” prompt window is displayed.

20. Start the program. Once program execution has been completed, the re-
sults are displayed.

21. Press the Next softkey.
A prompt window is displayed.

22. Follow the prompt.
23. Press the Next softkey.

The “Standard EMT mastering: check mastering” prompt window is dis-
played.

24. Check mastering.

25. Press the Next softkey.
The “Save MAMES data” prompt window is displayed.

26. Press the Save softkey.
The data are saved to the HD, RDC and DB. 

Further information is contained in the operating and programming instruc-
tions for the KUKA System Software (KSS).

Further information is contained in the operating and programming instruc-
tions for the KUKA System Software (KSS).

Further information is contained in the operating and programming instruc-
tions for the KUKA System Software (KSS).
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27. Press the Next softkey.
A prompt window is displayed. Answer the prompt with the Yes or No 
softkey.

6.3 Absolute calibration with the RCS Wizard

Precondition Krypton RemoteControl.exe is started on the Krypton computer.
The data have been entered and updated in the database.
A configuration has been created and updated in the database.
The network connection is established.
Operating mode T1 or T2.

Procedure 1. Start the KUKA System Software (KSS) 5.5.
2. Select the menu sequence Monitor > XRob RCS > Show.
3. Press the Next softkey.

A prompt window is displayed.
4. Select the calibration type. Press the AbsoluteC softkey.

The prompt is confirmed.
The configuration window is displayed.

5. Select the data from the created configuration in the boxes Payload 
group, Robot type, Arm extension, Installation type and Mounting 
platform.

6. Press the Next softkey.
7. Enter the robot serial number in the prompt window.
8. Press the Next softkey.

The configuration name, the entered comment and the robot serial number 
are displayed.

If the prompt is answered with Yes, the absolute calibration is started. If the 
prompt is answered with No, the Wizard can be closed. Press the Close 
softkey.

Fig. 6-4: Selecting a configuration
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9. Press the Next softkey.
The “Unmaster axes” prompt window is displayed.

10. Unmaster axes.

11. Press the Next softkey.
The “Master axes” prompt window is displayed.

12. Master the axes.

13. Press the Next softkey.
A message window is displayed.

14. Press the Next softkey to confirm the message.
A prompt window is displayed.

15. Follow the prompt.
16. Press the Next softkey.

A prompt window is displayed. 
17. Press the Next softkey to confirm the prompt.

The program for the control measurement is displayed.
18. Set mode selector switch to Automatic mode. Start the program. 

19. Set mode selector switch to T1 mode.
20. Press the Next softkey.

A prompt window is displayed.
21. Press the Next softkey to confirm the prompt.

The program for absolute calibration is displayed.
22. Start the program.

Once program execution has been completed, the results are displayed.

Further information is contained in the operating and programming instruc-
tions for the KUKA System Software (KSS).

Further information is contained in the operating and programming instruc-
tions for the KUKA System Software (KSS).

On completion of the control measurement, a message window is displayed. 
System ready for measurement must be highlighted in green. If this is not 
the case, an error has occurred.  (>>> 8.1 "Causes of errors during the test 
measurement" page 43)
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23. Press the Next softkey.
The “Positioning accuracy control measurement run” prompt window is 
displayed.

24. Press the Next softkey.
The program for the positioning accuracy control measurement run is dis-
played.

25. Set mode selector switch to Automatic mode. Start the program.
Once program execution has been completed, the results of the test run 
are displayed.

26. Press the Next softkey.
The “Save PID data” prompt window is displayed.

27. Press the Save softkey. 
The PID data are saved to the HD and RDC. 

Fig. 6-5: Absolute calibration results
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7 Messages

7.1 Viewing messages in the Event Viewer

Procedure 1. Open eventvwr.exe in the directory C:\WINDOWS\SYSTEM32. 
2. Select the menu sequence Action > Property to open the selected mes-

sage.

Description All messages are saved in the Event Viewer. The XRob RCS Event Viewer 
displays all messages called by KUKA.XRob RCS.

7.2 Error messages

Description Configuration or operator errors may result in error messages in an applica-
tion.

All messages are saved in the Event Viewer.

Fig. 7-1: Event Viewer

ID Message Cause Remedy
-61000 Error when saving PID data 

in the database.
No connection to database. Establish connection to 

database.
-25026 Error: saving of PID data on 

RDC failed
No connection to RDC. Establish connection to 

RDC.
-61011 Error when saving MAM 

data to RDC.
No connection to RDC.
Incorrect MAM file for-
mat on the hard disk.

Establish connection to 
RDC.
Repeat mastering.
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-25035 Error: saving of MAM data 
on hard drive failed.

MAM file could not be gen-
erated in the directory 
C:\KRC\ROBOTER\IR_SP
EC.

Deactivate write protec-
tion of directory 
C:\KRC\ROBOT-
ER\IR_SPEC.
Check that you have ac-
cess rights to write to 
the directory 
C:\KRC\ROBOT-
ER\IR_SPEC.

-25030 Error: MAM file could not be 
found in IR_SPEC directory.

MAM file 
<Serial_number>.mam 
could not be found in the 
directory 
C:\KRC\ROBOTER\IR_SP
EC.

Compare the file name of 
the MAM file with the pro-
grammed serial number of 
the robot (file name: 
<Serial_number>.mam)

-25032 Error: MAM file cannot be 
loaded from hard drive.

MAM file on hard drive 
faulty.

Repeat mastering.

-25033 Error: MAM file checksum 
incorrect.

Contents of the MAM file 
have been changed. 
Check sum check indi-
cates faulty file integrity.
Robot serial number or 
$Mames values have 
changed. 

Copy the original MAM 
file to the directory 
C:\KRC\ROBOT-
ER\IR_SPEC.
Check the programmed 
robot serial number and 
the $Mames values in 
$machine.dat.

-25037 Error: loading of a KRL vari-
able failed.

KRL variable could not be 
read.

Check whether the KRL 
variable can be read manu-
ally in the variable display of 
the GUI.

-61005 Error when saving the mas-
tering in the database.

No connection to database. Establish connection to 
database.

-61008 Error when saving meas-
ured values to the hard 
drive.

Measurement values file 
<Serial_number>.ist could 
not be generated in the 
specified directory (see 
XROBCONFIG.XML).

Deactivate write protec-
tion of specified directo-
ry (see 
XROBCONFIG.XML 
file).
Check that you have ac-
cess rights to write to 
the specified directory 
(see XROBCON-
FIG.XML file).

-61010 Error when calculating the 
mastering difference.

An error has occurred in the 
GUI function “Check mas-
tering”.

Repeat the GUI function 
“Check mastering”.

-61013 Error when reading 
$RAT_MOT_AX.

The KRL variable 
$RAT_MOT_AX[…] could 
not be read.

Check whether the KRL 
variable can be read manu-
ally in the variable display of 
the GUI.

-61014 Error when reading 
$RAT_MOT_ENC.

The KRL variable 
$RAT_MOT_ENC[…] could 
not be read.

Check whether the KRL 
variable can be read manu-
ally in the variable display of 
the GUI.

-61015 Error when reading 
$AXIS_RESO.

The KRL variable 
$AXIS_RESO[…] could not 
be read.

Check whether the KRL 
variable can be read manu-
ally in the variable display of 
the GUI.

ID Message Cause Remedy
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-61016 Error when reading the 
Mames values.

The KRL variable 
$mames[…] could not be 
read.

Check whether the KRL 
variable can be read manu-
ally in the variable display of 
the GUI.

-61017 Directory not found. The specified directory path 
for reading or writing files 
does not exist.

Check whether all directory 
paths specified in the file 
XROBCONFIG.XML exist 
on the hard drive.

-61019 Access to file denied. File could not be opened. Check that you have access 
rights to read and write to 
the file.

-61018 File not found File could not be found in 
the specified directory.

Check whether the file is 
present in the specified 
directory.

-61021 Input/output error. General error when access-
ing the storage medium.

Check access to the stor-
age medium.

-61035 Error when copying a file. An error occurred while a 
file was being copied.

Check access rights and 
write protection of source 
and target directory.

-61029 Error when setting the robot 
serial number.

Unable to set serial number 
in robot system.

Check whether the robot 
serial number can be set 
manually via the GUI menu 
item Setup.

-24001 Serious system error. 
Details can be found in 
XRob log.

Unusual cause. Cold start of the robot 
controller.
If the message is still 
present following a cold 
restart, inform KUKA 
Service.

-24004 Error in XRobConfig.xml 
file. (Section Command-
Handler) 

Entries in the Command-
Handlers section of XROB-
CONFIG.XML missing or 
incorrect. 

Use the log to isolate the 
cause of the error and 
improve the file XROBCON-
FIG.XML. 

-24010 Feature measurement error 
(sensor activation failed) 

Sensor with configured ID is 
not ready for measurement. 

Make sure that the feature 
is correctly configured and 
that the sensor is functional. 

-24011 Feature measurement error 
(sensor deactivation failed) 

Sensor is not ready for 
measurement.
Communication prob-
lems. 

Check that the measure-
ment system is ready for 
operation. 

-24012 Feature measurement error 
(trigger measurement) 

Communication problems 
with the sensor.

Check that the measure-
ment system is ready for 
operation. 

-24013 Feature measurement error 
(calling measurement data) 

Communication problems 
with the sensor 

Check that the measure-
ment system is ready for 
operation. 

-24017 Initialization of calibration 
failed 

An exceptional error has 
occurred. 

Analyze XRob log.
Cold start of the robot 
controller. 
If the message is still 
present following a cold 
restart, inform KUKA 
Service.

ID Message Cause Remedy
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8 Troubleshooting

8.1 Causes of errors during the test measurement

Error Cause Remedy

The message 
System ready is 
not highlighted in 
green.

The battery of the tool LEDs is 
depleted.

Exchange battery.
Charge battery.

The tool LEDs are defective. Exchange tool LEDs.
The Krypton strober for the tool LEDs 
is defective.

Exchange the Krypton strober.

The Krypton remote control for the 
tool and reference LEDs is defective.

Exchange the remote control.

The measured robot type does not 
match the selected configuration.

Select a different robot type in the 
configuration.
Remeasure the robot type.

The mounted tool does not match the 
tool in the configuration.

Select a different tool in the config-
uration.
Exchange tool.

The Krypton camera is defective. Exchange the Krypton camera.
No network connection between Kryp-
ton camera and KUKA KRC.

Check the network connections.
Connect the network connections.
Exchange the network connec-
tions.

The reference LEDs of the base plate 
are invisible or defective.

Make reference LEDs visible.
Check reference LEDs.
Exchange reference LEDs.

The Krypton strober for the reference 
LEDs of the base plate is defective.

Exchange the Krypton strober.
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9 KUKA Service

9.1 Requesting support

Introduction The KUKA Robot Group documentation offers information on operation and 
provides assistance with troubleshooting. For further assistance, please con-
tact your local KUKA subsidiary.

Information The following information is required for processing a support request:

Model and serial number of the robot
Model and serial number of the controller
Model and serial number of the linear unit (if applicable)
Version of the KUKA System Software
Optional software or modifications
Archive of the software
Application used
Any external axes used
Description of the problem, duration and frequency of the fault

9.2 KUKA Customer Support

Availability KUKA Customer Support is available in many countries. Please do not hesi-
tate to contact us if you have any questions.

Argentina Ruben Costantini S.A. (Agency)
Luis Angel Huergo 13 20
Parque Industrial
2400 San Francisco (CBA)
Argentina
Tel. +54 3564 421033
Fax +54 3564 428877
ventas@costantini-sa.com

Australia Marand Precision Engineering Pty. Ltd. (Agency)
153 Keys Road
Moorabbin
Victoria 31 89
Australia
Tel. +61 3 8552-0600
Fax +61 3 8552-0605
robotics@marand.com.au

Faults leading to production downtime are to be reported to the local KUKA 
subsidiary within one hour of their occurrence.
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Austria KUKA Roboter GmbH
Vertriebsbüro Österreich
Regensburger Strasse 9/1
4020 Linz
Austria
Tel. +43 732 784752
Fax +43 732 793880
office@kuka-roboter.at
www.kuka-roboter.at

Belgium KUKA Automatisering + Robots N.V.
Centrum Zuid 1031
3530 Houthalen
Belgium
Tel. +32 11 516160
Fax +32 11 526794
info@kuka.be
www.kuka.be

Brazil KUKA Roboter do Brasil Ltda.
Avenida Franz Liszt, 80
Parque Novo Mundo
Jd. Guançã
CEP 02151 900 São Paulo
SP Brazil
Tel. +55 11 69844900
Fax +55 11 62017883
info@kuka-roboter.com.br

Chile Robotec S.A. (Agency)
Santiago de Chile
Chile
Tel. +56 2 331-5951
Fax +56 2 331-5952
robotec@robotec.cl
www.robotec.cl

China KUKA Flexible Manufacturing Equipment (Shanghai) Co., Ltd.
Shanghai Qingpu Industrial Zone
No. 502 Tianying Rd.
201712 Shanghai
P.R. China
Tel. +86 21 5922-8652
Fax +86 21 5922-8538
Franz.Poeckl@kuka-sha.com.cn
www.kuka.cn
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France KUKA Automatisme + Robotique SAS
Techvallée
6 Avenue du Parc
91140 Villebon s/Yvette
France
Tel. +33 1 6931-6600
Fax +33 1 6931-6601
commercial@kuka.fr
www.kuka.fr

Germany KUKA Roboter GmbH
Blücherstr. 144
86165 Augsburg
Germany
Tel. +49 821 797-4000
Fax +49 821 797-1616
info@kuka-roboter.de
www.kuka-roboter.de

Hungary KUKA Robotics Hungaria Kft.
Fö út 140
2335 Taksony
Hungary
Tel. +36 24 501609
Fax +36 24 477031
info@kuka-robotics.hu

India KUKA Robotics, Private Limited
621 Galleria Towers
DLF Phase IV
122 002 Gurgaon
Haryana
India
Tel. +91 124 4148574
info@kuka.in
www.kuka.in

Italy KUKA Roboter Italia S.p.A.
Via Pavia 9/a - int.6
10098 Rivoli (TO)
Italy
Tel. +39 011 959-5013
Fax +39 011 959-5141
kuka@kuka.it
www.kuka.it
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Korea KUKA Robot Automation Korea Co. Ltd.
4 Ba 806 Sihwa Ind. Complex
Sung-Gok Dong, Ansan City
Kyunggi Do
425-110
Korea
Tel. +82 31 496-9937 or -9938
Fax +82 31 496-9939
info@kukakorea.com

Malaysia KUKA Robot Automation Sdn Bhd
South East Asia Regional Office
No. 24, Jalan TPP 1/10
Taman Industri Puchong
47100 Puchong
Selangor
Malaysia
Tel. +60 3 8061-0613 or -0614
Fax +60 3 8061-7386
info@kuka.com.my

Mexico KUKA de Mexico S. de R.L. de C.V.
Rio San Joaquin #339, Local 5
Colonia Pensil Sur
C.P. 11490 Mexico D.F.
Mexico
Tel. +52 55 5203-8407
Fax +52 55 5203-8148
info@kuka.com.mx

Norway KUKA Sveiseanlegg + Roboter
Bryggeveien 9
2821 Gjövik
Norway
Tel. +47 61 133422
Fax +47 61 186200
geir.ulsrud@kuka.no

Portugal KUKA Sistemas de Automatización S.A.
Rua do Alto da Guerra n° 50
Armazém 04
2910 011 Setúbal
Portugal
Tel. +351 265 729780
Fax +351 265 729782
kuka@mail.telepac.pt
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Russia KUKA-VAZ Engineering
Jushnoje Chaussee, 36 VAZ, PTO
445633 Togliatti
Russia
Tel. +7 8482 391249 or 370564
Fax +7 8482 736730
Y.Klychkov@VAZ.RU

South Africa Jendamark Automation LTD (Agency)
76a York Road
North End
6000 Port Elizabeth
South Africa
Tel. +27 41 391 4700
Fax +27 41 373 3869
www.jendamark.co.za

Spain KUKA Sistemas de Automatización S.A.
Pol. Industrial
Torrent de la Pastera
Carrer del Bages s/n
08800 Vilanova i la Geltrú (Barcelona)
Spain
Tel. +34 93 814-2353
Fax +34 93 814-2950
Comercial@kuka-e.com
www.kuka-e.com

Sweden KUKA Svetsanläggningar + Robotar AB
A. Odhners gata 15
421 30 Västra Frölunda
Sweden
Tel. +46 31 7266-200
Fax +46 31 7266-201
info@kuka.se

Switzerland KUKA Roboter Schweiz AG
Riedstr. 7
8953 Dietikon
Switzerland
Tel. +41 44 74490-90
Fax +41 44 74490-91
info@kuka-roboter.ch
www.kuka-roboter.ch
49 / 53ed: 05.03.2008 Version: LastRecentFinal en



KUKA.XRob RCS
Taiwan KUKA Robot Automation Taiwan Co. Ltd.
136, Section 2, Huanjung E. Road
Jungli City, Taoyuan
Taiwan 320
Tel. +886 3 4371902
Fax +886 3 2830023
info@kuka.com.tw
www.kuka.com.tw

Thailand KUKA Robot Automation (M)SdnBhd
Thailand Office
c/o Maccall System Co. Ltd.
49/9-10 Soi Kingkaew 30 Kingkaew Road
Tt. Rachatheva, A. Bangpli
Samutprakarn
10540 Thailand
Tel. +66 2 7502737
Fax +66 2 6612355
atika@ji-net.com
www.kuka-roboter.de

UK KUKA Automation + Robotics
Hereward Rise
Halesowen
B62 8AN
UK
Tel. +44 121 585-0800
Fax +44 121 585-0900
sales@kuka.co.uk

USA KUKA Robotics Corp.
22500 Key Drive
Clinton Township
48036 Michigan
USA
Tel. +1 866 8735852
Fax +1 586 5692087
info@kukarobotics.com
www.kukarobotics.com
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Load data, editing 23
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Messages 39
Microsoft SQL Server Desktop Engine, uninstall-
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MSDE, uninstalling 12

O
Operation 31
Overall load 17

P
PID data 6
Pose data, editing 24
Product description 7

R
RCS 6
RDC 6
Robot data, editing 24
Robot type data, editing 24
Robot types, configuring 25

S
Safety 9
Safety instructions 5
Saving settings 16
Selecting a configuration 26
Service, KUKA Roboter 45
Support request 45
System requirements 11

T
Target group 5
Terms used 6
Tool data, editing 23
Tool data, entering 16
Tool LEDs 6
Tool locating holes 6
Training program 5
Troubleshooting 43

W
Warnings 5
Wizard 31, 35
Wizard, installing 13
Wizard, re-installing 13
Wizard, uninstalling 13

X
X-Rob 6
XRob database, uninstalling 12
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